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1 Long Term Potentiation (LTP) 

1.1 Aim of Experiment 

 

This experiment was performed on an acute hippocampal slice on a microelectrode array  
(MEA) with 64 channels with the aim to analyze long-term potentiation (LTP) following 
electrical stimulation. 

The 300 μm thick acute hippocampus slice was prepared from a 21 days old rat. The slice was 
stimulated every 60 s with the test stimulus, a single biphasic pulse with 1.5 V amplitude  
and 100 μs duration per phase, by using one of the embedded MEA electrodes (No. 75). 

 

Fig. 1 Test stimulus for LTP experiment 

The screen shot from the MC_Stimulus program shows the biphasic test pulse (amplitude: 1.5 V, 
duration: 100 μs per phase, inter-stimulus-interval: 60 s). The red trace is the Sync Out (TTL) pulse 
that was used for triggering the recording. 
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LTP was induced by an LTP train with 100 pulses of same amplitude and duration as the test 
stimulus, and a frequency of 100 Hz. The Sync Out signal of the STG (stimulus generator) has been 
used to trigger the recording, with a pre-trigger of 30 ms and a time window of 100 ms. Data was 
recorded before and after the LTP induction; the LTP induction itself was not recorded. 

 

Fig. 2 Pulse train of 100 biphasic pulses for LTP induction 

Amplitude: 1.5 V, duration: 100 μs per phase, inter-stimulus-interval/frequency: 10 ms / 100 Hz) 

As the data was acquired with a MEA1060-BC amplifier with blanking circuit, all MEA electrodes 
were disconnected from the amplifier shortly during stimulation, in this case for 540 μs  
(300 μs Sync Out pulse of the STG, plus intrinsic Wait of 40 μs, plus user-defined Wait of 200 μs). 
This efficiently prevented stimulus artifacts. 

The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 

Task 

Show the impact of an LTP train on the LTP peak-to-peak amplitude by an offline analysis; graph, 
print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Neuro_LTP_Demo.rck  

 Data file: LTP-Demo.mcd (recorded after LTP induction) , preLTP-Demo.mcd (recorded before 
LTP induction)  

 Image file: LTP_slice.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Record data (Recorder) 

 Analyze field potentials, for example, extract peak to peak amplitudes (Analyzer) 

 Plot the amplitude vs. time (Parameter Display) 

 How to customize the rack: 

 Modify the display layout (all display types) 

 Rename virtual instruments for a better overview (all virtual instruments) 
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 More details: 

 Align the data traces to a slice picture (Analyzer, Data, or Averager display) 

 Customize the colors of the traces and axes in the display (all display types) 

1.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Neuro_LTP_Demo.rck". Click Open on the 
File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file LTP-Demo.mcd into the Replayer. 

 

1.3 Analyzing Field Potentials 

You can use a virtual Analyzer for extracting parameters of interest, for example,  
the minimum or maximum, the amplitude, or the slope from a region of interest (ROI)  
of the field potentials. 

As the data was recorded on a trigger (the Sync Out pulse of the stimulator) and the region  
of interest needs to be specified relative to a trigger event, the Analyzer will also operate based 
on this trigger. In an online experiment, you would now have to define the trigger with a Trigger 
Detector. In the data file, the trigger was already recorded together with the raw data, and  
you can use the existing trigger for triggering the Analyzer. (In this experiment, more than  
one trigger were used, but trigger 2 was used for recording the data, trigger 1 was not saved. 
Therefore, there is only trigger 2 available in the data file.) You can see this information on the 
File Info page of the Replayer. 

1. On the toolbar, click  to add an Analyzer to the virtual rack configuration. 

2. Select now the channels you are interested in. Start with all channels, you can then later decide to 
deselect channels with no LFP responses (for optimizing the computer performance). For example, 
you can deselect the stimulating electrode No. 75, or electrodes that are not covered by the slice. 

3. In the tree view pane of the virtual rack, select the Analyzer and click the Channels tab  
of the Analyzer. 
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4. Click the data stream Electrode Raw Data. On the right half of the Channels page,  
the channels appear in the standard 8 x 8 MEA grid. 

5. Select the check box next to the stream name to select all channels or click the buttons with  
the electrode numbers to pick single channels. The check box next to the stream name appears 
shaded if some, but not all channels have been selected. 
 

 

6. Click the ROI tabbed page, which stands for region of interest. Start on Trigger 2  
is preselected, because the recording of this data file was triggered on trigger 2. The option 
Continuous is not available, because the sample data is not a continuously recorded file. 
 

 
 
The Analyzer displays the electrode channels in the layout of the Channel Map  
you have created or loaded. 
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1.4 Customizing the Display Layout 

The following information applies not only to the Analyzer display, but also to other displays, 
such as the Raw Data display or the Parameter display. 

Hint: Channel maps are provided for all MEA types available from Multi Channel Systems. You can 
download channel maps for all MEAs available from Ayanda Biosystems from the Ayanda web 
site (http://www.ayanda-biosys.com/download.html). You can also set up custom channel maps 
with a preselected number of electrodes and save them for later use. 

1. In the tree view pane of the virtual rack, select the Analyzer and click Layout. 

2. To load a Channel Map in the MEA layout, click Open. 

3. Browse your folders and open the MC_Rack program folder. 

4. Select the appropriate MEA layout, for example, the 8x8mea.cmp file for standard 8 x 8 MEAs, 
and click Open. The MEA layout appears on the right side of the dialog box, and the 
corresponding display is updated accordingly. 
 

 

5. Switch to the Analyzer display. You can choose the appropriate range of the y-axis from the 
drop-down list. The x-range and the display refresh rate are defined by the sweep time. You  
can see on the File Info page of the Replayer that the data is triggered and that one sweep  
is 100 ms long. Therefore, the maximum range of the x-axis is 100 ms. You can fine-tune the 
ranges with the sliders. 

1.5 Renaming Virtual Instruments 

You can rename instruments for a better overview. This is especially useful if you use  
the same type of virtual instrument several times, for different purposes, in the same rack. 

1. In the tree view pane of the virtual rack, select the Analyzer 1, and then click its name  
(do not double-click it). An insertion point appears. 
 

 

2. Type in the new name, for example Peak-Peak Amplitude. 
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1.6 Zooming into a Single Channel 

In all displays, you can switch to a single channel by double-clicking the channel in the display. 

1. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 

2. Double-click channel No. 65 in the Analyzer display. As the pathway that is going to be analyzed 
in this experiment is directed from the right to the left in the slice, the electrodes of interest are 
left of the stimulating electrode. 
 

 
 

The magnifying-glass icon  on the top left indicates that you have zoomed to a single channel. 

3. Zoom in the y-axis by moving the two sliders to each other. 
 

 

4. Move the range by clicking in the middle between the two sliders and dragging with your 
mouse or pressing the LEFT ARROW and the RIGHT ARROW keys. For larger steps, you can also  
use the PAGE UP / PAGE DOWN keys. 

5. Zoom the x-axis as well until you have centered on the response following the stimulus  
(at time point 0). 
 

 

6. Double-click the display again to switch back to the full channel view. 
The settings have been applied to all channels. 
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1.7 Aligning the Data Traces to a Slice Picture 

You can load a digital photograph of the acute slice as a background picture and align  
the signals to the electrodes and the regions of the slice. 

Hint: Crop the picture in a graphics program so that only the electrode array is visible.  
This helps saving (unused) space on the screen. 

1. On the File menu, click Load Image. 

2. Browse your folders and open the Tutorial folder on the installation volume. 

3. Select the LTP_slice.jpg file and click Open. 

4. On the Analyzer or Data Display, click Show Image. 
You can now see the slice picture. 

5. Now, you map the channels to the electrodes in the picture. Hold down the SHIFT key,  
point to any electrode in the picture, for example No. 77, and double-click. 
 

 
 
A text box opens. 

6. Type in the number of the electrode according to the MEA layout, for example 77. 

7. Hold down the CTRL key, point to any electrode in another row and column,  
for example No. 44, and double-click. 

8. Type in the number of the electrode according to the MEA layout, for example 44. 
The data traces appear on top of the picture. 
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9. You can resize the window by dragging the window frame with the mouse. 
The graphic will be scaled accordingly. 
 

 

Note: If you have made a mistake, simply repeat the assignment from step 58. 

Hint: If you record data with a background picture in your rack, the file path of the picture  
is saved together with the data, that is, it is opened automatically when you replay the file  
in a rack that has a Display with the Show Image option selected. (File paths are absolute,  
that means MC_Rack cannot find picture files if they have been moved to another folder or 
directory. You will be informed by an error message.) 

1.8 Customizing the Display Colors 

It may be difficult to see the traces or the axes because the contrast of the trace color to the 
background color is too low. You can define the colors of the traces and the axes to improve  
the view. 

1. Point to any trace or to an axis and right-click. 
The Color dialog box opens. 
 

 

2. Choose a color from the palette or set up a custom color. 
The color of all traces or of the axes is changed accordingly. 
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1.9 Extracting Parameters 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). It is very important  
to define this time frame appropriately for all channels of interest, because otherwise  
you will not obtain any proper results from the Analyzer. 

1. In the tree view pane of the virtual rack, select the Analyzer, and click the Analyzer tab.  
Select the parameters you like to extract, Peak-Peak Ampl. in this case. 
 

 

2. Now, you have to define the ROI. Look at the Raw Data traces again in the Analyzer display  
and select a range that includes the biological responses on all channels. Shortly after the stimulus 
/ trigger event (time = 0) will be fine. You can define the region of interest with by dragging the 
two vertical bars in the display, or by editing the T1 and T2 boxes on the ROI tabbed page of the 
Analyzer. For example, the start time (= T1) can be set to 1 ms (after the trigger event) and the 
stop time (= T2) 41 ms. 
The selected parameters of interest will then be extracted from the region of interest, and can 
then be recorded to a data file, and / or plotted using a Parameter display. 
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1.10 Plotting Amplitude versus Time 

Add a display to graph the peak-to-peak parameter. As a parameter data stream is very different 
from raw data, MC_Rack features a specialized display type, the Parameter Display, which  
is optimized for parameter streams. 

 In the tree view pane of the virtual rack, select the Analyzer and click  on the toolbar to add  
a Parameter Display in series with the Analyzer to the virtual rack. (It would not be possible  
to add the Parameter Display in parallel to the Analyzer, as the replayed data file does not 
contain any parameter streams as input streams for the display, and virtual instruments can only 
use the output streams of other virtual instruments that are upstream in the virtual rack tree.) 
Rename the display to Amplitude vs. Time. 

 

Customizing the display layout 

You can define the layout for each display separately. If you have selected all channels as an input 
for the analyzer, you may want to see the plot for all channels as well, for example. On the other 
hand, you may be interested in monitoring only one or two representative channels online  
(for saving space on the screen or for saving computer performance). (You can still save the 
parameters of all channels in the data file to review it later or to analyze it further in your 
custom evaluation software.) Set up a custom layout with only one electrode of interest now. 

Hint: Try typing the channel numbers instead of selecting them from the drop-down list  
with the mouse.  

1. Click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a custom layout with a single channel appears. 

3. Assign the appropriate channel numbers to the empty slots. Click the empty slot to select it.  
The active slot is highlighted by a dotted line. 

4. Select 65 for the active slot from the Channel list, or type 65. 
The Parameter Display is updated accordingly. Likewise, you can set up any custom 
configuration for all display types. 
 

 



Long Term Potentiation (LTP) 

15 

Selecting data streams 

Now, select the data that you like to be displayed. 

1. Click the Data tab. 
The Peak-to-Peak Amplitude is already preselected. The plot type is set to Trace, meaning  
that a curve is plotted. These settings are ok and do not have to be modified in the moment. 
 

 

Setting the window extent 

As you can see on the File Info page of the Replayer, the total recording time of the example 
file is about 3 hours. Adjust the ranges of the y-axis as well. 

1. Click the Ranges tab. 

2. Enter 3 h for the x-axis range, and 4 mV for the y-axis. 
 

 

 

1. Click Start  to graph the plots. The baseline and the LTP induction were not recorded.  
The high amplitudes at the beginning demonstrate the effect of short term potentiation. LTP 
starts after about 20 min following the LTP induction. The amplitude slowly decreases over time. 
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1.11 Zooming and Scrolling 

Zooming to a single channel 

To provide an overall view of the ongoing activity, normally all channels (depending  
on the layout) are shown in the parameter display. 

 Simply double-click a channel to have a closer look at it. The magnifying glass icon   
in the upper left corner indicates the zoom mode. 
 
Double-click the zoomed channel again to switch back to the overall view. 

Scrolling back and forward 

You can scroll the data forward and backward along the time axis. You are able to look  
for a region of the plot you are interested in and snapshot the displayed region. 

 On the tool bar, click  to scroll backward and  to scroll forward. 

 Click  if you like to jump to the beginning of the plot. 

 Click  if you like to jump to the end of the plot. 

Scaling the x- and y-axis 

You can zoom the x- and y-axis in and out separately. The left button array on the toolbar 
corresponds to the x-axis and the right button array to the y-axis. 

 Decide which axis you like to scale and click the corresponding  button to zoom the axis  

in and  to zoom it out. The display will be updated accordingly. 

 To reset the scaling of the x-axis to default, click . 

 Likewise, click  to reset the scaling of the y-axis. 

 If you have zoomed to a single channel, you can click the Apply to All button  to apply the 
settings to all channels. If you do not use this button and switch back to the overall view, any 
changes to the settings are lost. 

1.12 Saving a Picture 

You can take a screen shot of the Parameter Display. This feature is especially useful for  
quickly setting up illustrations and presentations. Each visible channel on your display is saved  
as a separate image file. Each file has the chosen file name extended by channel number.  
If, for example, the entered file name is Peak-to-Peak, the file name of channel 41 will be  
Peak-to-Peak_41.jpg. 

Note: Only the channels that are currently shown on the display are captured. Therefore,  
if you want to capture all channels, click the Snapshot button when all channels are visible.  
If you want to capture only a single channel, zoom this channel and then click the Snapshot 
button. 

Hint: If you need more features for data screen shots, Multi Channel Systems recommends  
to use a commercially available screen shot program. 

1. On the Parameter Display toolbar, click the Snapshot button  to take screen shots  
of the displayed channel(s). The Save As dialog box opens. 
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2. Select an image file format from the drop-down list: 
(*.emf), Enhanced Meta File format (vector graphics) 
(*.bmp), bitmap 
(*.jpg), compressed bitmap in JPEG format 

3. Enter a file name. 
 

 
 
The file name will automatically be extended by the channel number. 

4. Confirm by clicking Save. 

1.13 ASCII Export 

You can save the displayed data as an ASCII file (text without formatting). You may then send 
this data to an editor or to your custom analyzing software, for example. This feature is also very 
convenient if you want to generate custom graphics, for example, with Microsoft Excel or 
Micrococcal Origin. 

Saving data is only possible when you have stopped the recording. The Save button will reappear 
on the toolbar. 

Note: Only the channels that are currently shown on the display are saved. In the example given 
below, only the Peak-to-Peak amplitude of the channel 65 will be saved. Therefore, if you want  
to save all channels in a single file, click the Save button when all channels are visible. If you 
want to save the parameter values of a single channel only, zoom this channel and then click  
the Save button. 

Hint: If you need more features, for example, export of raw data, use the add-on program 
MC_DataTool that comes together with ME- / MEA-Systems. 
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1. Click the Save button  on the Parameter Display toolbar to open the Save As dialog. 
The Save As dialog box will be opened. 

2. Type in a file name and path and click Save. 

 

You can now open and process the file with any text editor, spreadsheet, or any other custom 
evaluation software. The following screen shot shows how it looks when the filet is opened  
with a standard spreadsheet. The first row contains the axes headers. The first column contains 
the x-values (in hours), the second column the y-values of channel 65 ( in micro volts). 

 

1.14 Recording Analyzed Data 

Now, the virtual rack for offline analysis of LTP experiments has been completed, and you can 
select the data that should be recorded, that is, saved in the generated data file. It is important  
to know that MC_Rack never modifies or overwrites an existing data file. That means, in an 
offline analysis, the extracted parameter streams are stored in a new data file. Therefore, you 
need to specify a file name and path in the Recorder for both online and offline analysis. 

Hint: If you want to store raw data and extracted parameters in the same data file, you can select 
the already existing raw data traces in a replayed file for rerecording them together with the 
extracted parameter streams. 

1. Select the Recorder and click the Channels tab. 
You see all data streams on the left. You can now select any channels you like, independently 
from the channels you view on screen with MC_Rack. To select the Electrode Raw Data stream 
does not make much sense in this case, because the data file already exists and is only replayed  
in this tutorial. But if you performed an online analysis, you would probably want to save the  
raw data (cutout sweeps triggered on the stimulus) of the relevant channels. 
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2. In this case, we are interested in the Peak to Peak parameters. Select the Parameter 1 data 
stream. All available channels appear in a button array on the right side. (Remember: Available 
are those channels that have been assigned to the Analyzer and thus have been processed by  
the Analyzer. If you change the Analyzer input, you will see that the recordable output will  
be changed accordingly.) 

3. Select all channels by selecting the check box, or pick single channels. All channels selected  
on this page will be saved in the specified file when you start the recording. (If you have not 
already specified the file and path on the Recorder tabbed page, do so now.) 
 

 
 
Click the Record button and then Start again. 
 

 

4. The data will now be replayed and the selected data streams will now be saved to the specified 
location. You can then replay the newly generated file with the Replayer and a Parameter 
Display. You can also export the data to your custom graphics or analysis software. 

Note: Do not forget to enable the recording by clicking the Record button  !  
Otherwise, no data will be stored. 
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2 Saving the Rack and Saving Data 

2.1 Saving a Rack 

Save the virtual rack configuration if you like to keep it for future use, for example for an offline 
analysis of identical data recorded in another experiment. 

1. On the File menu, click Save As. 

2. The Save As dialog box opens. 

3. Browse your folders and select a path. 

4. Enter a file name and confirm by clicking Save. 

The file extension for the rack files is .rck. 

2.2 Selecting Data Streams for Recording 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack. That 
means, that you could record to hard disk completely different data streams and channels than 
you monitor on the screen. This has the advantage that you can store exactly the channels you 
are interested in, but it also has the slight disadvantage that all virtual instruments have to be set 
up separately. Please be especially careful when configuring the Recorder, to avoid data loss. 

When you have finished setting up the rack, you can select the data streams and channels that 
you want to save to the data file specified in the Recorder. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

1. Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your rack configuration. When replaying data, you are generally more interested in the 
parameter data streams, but you can rerecord the raw data as well, in case that you want to save 
the raw data and the extracted parameters to the same data file. 
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2. Click the data stream that you are interested in, generally the parameter streams. 
The available electrode channels appear in a button array on the right side. Parameter stream 1  
is generated by the first analyzer in the rack (here: for extracting the peak-peak amplitude), 
parameter 2 is generated by the second analyzer (here: for extracting the slope). 
 

 

3. You can now either select all channels by clicking the check box next to the data stream name,  
or you can pick single channels by clicking the corresponding buttons. For more information, 
please see "Channel Selection" in the MC_Rack Features section. Only data from the selected 
channels will be saved to the hard disk. 

2.3 Creating a Data File 

If you want to write the parameters that you will extract in an offline analysis to the hard disk, 
you have to specify the file name and path in the Recorder. (It is not possible to change or 
overwrite existing data files in MC_Rack, for example, adding the spike rate to an existing data 
file, but you can record the raw data together with the spike rate stream to the same file.) 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 

The data file is then generated automatically when you start MC_Rack in recording mode.  
The file extension for the data files is *.mcd. 
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File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 

Selecting data streams and channels 

As has been said before, the fate of each single channel is independent from other channels. 
You can pick exactly the channels you like to save from all generated data streams. For example, 
you can decide to save only one channel of raw data, but the peak-to-peak amplitude results 
of all, or of a specific selection of channels. 

 Click the Channels tab. 

As long as the rack is still empty, you see an empty box. There are no channels available at this 
point, because you have not chosen a data source yet (MC_Card for online data acquisition or 
Replayer for replaying data files). Without a data source, there are no data streams available  
for recording. Remember later, when you have completed the rack, to assign the channels that 
you like to save to the data file to the Recorder. 

After you added a data source, you will see the electrode raw data streams provided by the data 
source (for example, electrode raw data, analog data, and digital data from the MC_Card, or the 
data streams included in the data file loaded into the Replayer). If the rack file contains virtual 
instruments that generate data streams such as Spikes from a Spike Sorter or Parameter streams 
from an Analyzer, these data streams will be available for recording as well. 

2.4 Starting Data Acquisition and Recording 

Now that you have completed the virtual rack, you are ready to start the rack. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record  and then Start  to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop  to stop the data acquisition. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder are 
saved in your data file when you start a recording. Data is only saved to the hard disk when the 
red Record button is pressed in. Make always sure that you have selected all channels of interest, 
and that the Record button is active before starting an experiment to avoid data loss. 

 


